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Regulatory Information

About This Document - This manual is intended for administrators and operators of AXIS Camera 
Station and is applicable for software version 1.20. 

Later versions of the document will be posted to the Axis Web site, as required. Previous experience of 
networking will be of use to the reader when installing and using this product. 

Legal Considerations - Camera surveillance may be prohibited by laws that vary from country to 
country. Check the laws in your local region before using AXIS Camera Station for surveillance purposes.

Liability - Every care has been taken in the preparation of this manual. Please inform your local Axis 
office of any inaccuracies or omissions. Axis Communications AB cannot be held responsible for any 
technical or typographical errors and reserves the right to make changes to the product and manuals 
without prior notice. Axis Communications AB makes no warranty of any kind with regard to the material 
contained within this document, including, but not limited to, the implied warranties of merchantability 
and fitness for a particular purpose. Axis Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the furnishing, performance or use of this material.

Trademark Acknowledgments - Internet Explorer, Microsoft, Windows, .NET are registered 
trademarks. 

Axis Support Services - Should you require any technical assistance, please contact your Axis 
reseller. If your questions cannot be answered immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. 

If you are connected to the Internet, you can:

• Download user documentation and firmware updates.
• Find answers to common problems in the FAQ database. Search by product, category, or phrases.
• Report problems to Axis support staff by logging in to your private support area.

Visit the Axis Support Web: www.axis.com/techsup
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AXIS Camera Station - Minimum System Requirements
• Install AXIS Camera Station on a stand-alone computer dedicated to 

mainly run this application
• Use a static IP address on the dedicated computer
• Intel Pentium 4 with 1 GHz processor (2 GHz or higher recommended)
• 512 MB RAM
• Hard disk: 1 GB for installation and 2 GB or higher per camera as image 

database (the storage capacity can be calculated using the bandwidth 
calculator available at www.axis.com/techsup/cam_servers/bandwidth/)

• NTFS file system
• CD-drive
• XGA (1024 x 768) or higher resolution monitor
• Graphic card with 32 MB or more memory
• Microsoft mouse or compatible pointing device
• 100 Mbit Ethernet
• Microsoft Windows XP Professional SP2, Windows Server 2003 or Windows 

2000 with SP4
• Microsoft Internet Explorer Version 6.0 or later
• Internet Information Server (IIS) installed on the C-drive of your server if 

you intend to use the web interface
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Overview
This document will help you install AXIS Camera Station and 
configure it for your Axis Network Cameras and Axis Video 
Servers. A brief introduction to the functionality of the software is 
covered here, see the online Help or the AXIS Camera Station 
User’s Manual for a detailed description. The User’s Manual is 
available on the CD and on www.axis.com

AXIS Camera Station is a complete monitoring and recording 
system for use with Axis Network Cameras and Video Servers.

The application's main window provides quick and easy access to 
all connected and configured cameras, to all recordings and to 
inputs and outputs used in the system. AXIS Camera Station runs 
as a background service in Windows.

Administration
The Administration section of the application allows complete 
control and configuration of all aspects of the system. The 
Administration section is opened from the File menu in AXIS 
Camera Station. 

Remote clients
For remote clients you can use “AXIS Camera Station Client 
software” described on page 21 or “AXIS Camera Station Web 
application” described on page 23.
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Network Configuration
The AXIS Camera Station can record and playback video feed from 
cameras that are connected over a local area network or over the 
Internet.

Local Area Network

The cameras can be connected directly to the server running AXIS 
Camera Station using an Ethernet network. 

Over the Internet

To access AXIS Camera Station from the Internet and get live 
images from the cameras you must open a set of IP addresses and 
port numbers in your firewall configuration.

There must be a port open for each Axis camera/video server and 
one port for AXIS Camera Station.
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See the User’s Manual for details, available on the CD and on 
www.axis.com
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Install AXIS Camera Station Software

1. Insert the CD in the CD drive. If the installation CD does not 
auto-start, click autorun.exe in the CD’s root folder. 

2. From the CD’s interface, click Software and then AXIS 
Camera Station

3. Click Open to launch the installation. 

Note:

4. Next, you will be asked where you wish to install the program. 
If nothing is specified the program is normally installed in 
C:\Program Files\Axis Communications\AXIS Camera 
Station.

Install AXIS Camera Station on the dedicated stand-alone PC from which you 
wish to run the main administration of your cameras and video servers.

You may be prompted to install .NET Framework 1.1. Simply follow the 
installation Wizard’s instructions and click your way through.

You may be prompted and then automatically redirected to 
http://windowsupdate.microsoft.com to locate and install these missing 
Windows components: 

• Windows 2000 Service Pack 4, located here:
http://www.microsoft.com/windows2000/downloads/servicepacks/

• Windows Internet Explorer 6, located here: 
http://www.microsoft.com/windows/ie

Install the missing components, see your Windows documentation for 
instructions. When this is done, reboot your computer and then restart the AXIS 
Camera Station installation by clicking AXISCameraStationSetup.exe on the 
CD. 
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5. Click your way through the Installation Wizard. 

6. When you are finished, open AXIS Camera Station from Start 
| Program Files or click the program icon on your desktop:

Note:

Activate the software with your License Key

Important!

Registering with a direct Internet connection

1. The first time you start the program you will be asked to 
register your license. Click Register.

If running Windows XP, you will need to permit the firewall to accept incoming 
requests from AXIS Camera Station Client when prompted.

Before starting AXIS Camera Station, the hard disks where you save images 
must be NTFS formatted, which is the default in Windows 2000/XP. See the 
User’s Manual for details. The AXIS Camera Station User’s Manual is available 
on the CD and on www.axis.com

• The License Key can only be used to install the software on a single com-
puter.

• The License Key is your proof of purchase, keep it in a safe place for future 
reference.

When entering licensing information, e.g. the License key and Access code, 
remember that they are both case sensitive.
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2. Fill in the requested information, you will find your License 
Key on the inside of the AXIS Camera Station CD casing, to 
the left. Click Activate.

3. Your license information will be sent to Axis Communications 
and your software will be activated automatically. 

4. You can now start using AXIS Camera Station.

Registering without a direct Internet connection 

If you do not have Internet access from the computer running 
AXIS Camera Station, you can choose the 5-day grace period, 
where you will have a complete functional program for 5 days. 
During this time, you can use another computer with Internet 
access to register the program, see below.

1. Click Grace period. 

Enter License Key
(found inside CD casing)

The entered characters
are case-sensitive!
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2. Enter the License Key and click Activate Grace Period.

3. You will see your Server ID (a code containing information 
about your PC). 

4. You can now use AXIS Camera Station for 5 days.

5. During the grace period you can receive the Access Code by 
using any computer with Internet access to browse to 
http://www.axis.com/techsup/acs and fill in the requested 
information. When complete click Submit.

6. When you have received the Access Code, select Yes when 
starting up AXIS Camera Station.
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7. Enter your Access Code and click Activate.

8. You can now start using AXIS Camera Station.

Using the demo version

Another option is to install AXIS Camera Station as a 30-day 
demo version, which works with 4 cameras.

Entered characters
are case-sensitive!
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Configure AXIS Camera Station
After installing the software, it must be configured for your 
cameras and video servers. All camera/video server configuration 
is done from the Administration pages.

1. From the AXIS Camera Station, click File | Administration:

Note:

The Administration pages contain all configuration settings. Only a few of the 
most essential settings are covered in this guide. See the online Help or User’s 
Manual for a full description.

File | Administration
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2. From the Cameras tab, fill in this information: 

Notes:

• Click the ”?” button to identify the Axis camera/video server model.
• In the Camera Type field, specify the connected Axis video server if using an 

analog CCTV camera.
• The WAN must be specified if a client or web interface client is run from 

another network than AXIS Camera Station. If no WAN address is available, 
enter the LAN address.

 2.1 Select camera

2.2 Camera 
enabled checkbox 
must be checked.

2.3 Name the  
camera.

2.5 Click “?” to get
the correct 
camera or video 
server type.
 

Enter camera’s 
Local IP address
(LAN) or host

2.7 Enter camera’s
User and password
default user = root
default pass = pass

2.9 Check connection to camera by clicking Test Image.

2.4

2.10 Click Apply.

2.6 For video 
servers, specify 
video port 
number in 
Camera port 
number field.

to configure.

name.

2.8 Open the camera’s web page to set properties by clicking Link to Camera.
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3. Next, under Views, define the camera views as seen from the 
main AXIS Camera Station user interface. 

4. Under General, make sure that the IP address of the local 
dedicated computer is entered in the Server IP address field.

5. If you have cameras outside your local network and a proxy 
server is used for external network access, refer to the User’s 
Manual for how to configure the proxy settings,

6. From the AXIS Camera Station interface, select a 
camera view by clicking one of the View Selection 
buttons:

7. The camera will now appear in the main window, 
where live images from the cameras are shown.

You have now performed the minimum required setup in the Administration 
pages. For instructions on configuring recordings, alarms, motion detection, 
scheduling, etc., see the User’s Manual.

3.1 Select view according
  

3.3 Select camera 
 

3.5 Click OK to save and exit.

Example:
To configure 4 
cameras, select
To configure 9
cameras, select

3.2 Select camera position
 

3.4 Repeat 3.2 and 3.3 for all cameras.

to the number of
cameras you want to
configure. 
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AXIS Camera Station User Interface

Click to
expand
view

Red light = background recording 
service is not running.

Green light = background recording 
 service is running.

The frames surrounding the images are color-coded:
Blue frame: Camera connection OK, no motion detected
Red frame: Camera connection OK, motion detected or recording has started
Yellow frame: Camera network connection interrupted 
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Notes:

• The background recording service retrieves images from the connected 
cameras and stores them to hard disk. From the AXIS Camera Station you 
can start or stop the background service, click File | Administration | Start 
Server or Stop Server.

• When the service is running there is a flashing green indicator in the upper 
right corner of the window. A flashing red indicator means the service has 
stopped. When the service is running there is also a green icon in the task 
bar, a red icon means the service has stopped and a yellow icon indicates 
that the service is starting up or experiencing problems connecting to one 
of the cameras.

• Recording is only possible if the background service is running, and will 
continue even after logging out from the PC where AXIS Camera Station is 
installed. 

• The background service will automatically start running upon system 
start-up. This auto-start function can be disabled under Windows Control 
Panel | Administrative Tools | Services | AXIS Camera Station. Right-click, 
select Properties | General | Start-up Type => Manual. 
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AXIS Camera Station Control Buttons
View Selection Select a view and you will get a window 

showing live images direct from the camera. 
It is possible to click in the image from 
Pan/Tilt/Zoom cameras to move the camera 
or zoom using the mouse scroll wheel.

No Live Images Click the No Live Images button to close the 
camera windows. Showing live images in the 
main window uses a lot of processor power. 
Not displaying live images reduces the 
amount of processor power required by the 
service, whilst not affecting recordings in 
any way. The amount of bandwidth required 
is also less when not showing live images. In 
the Views section of the Administration 
pages it is possible to set up the system so 
that it always starts in this mode.

Select Camera Select a camera to be shown in a new 
window. Choose this if you want to close the 
view windows (and thus save on processor 
power) but still want a single camera view 
visible on your desktop. Controls for 
Pan/Tilt/Zoom, audio and AXIS Image 
Enhancer may also be shown in this window.
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Monitoring I/O When clicking this button, the I/O Status of 
all units are displayed. Monitoring I/O 
defines when events, such as an alarm or 
motion detection, should be triggered. Each 
I/O is shown on one line, along with a 
colored indicator:

• green indicator means the I/O is in its 
normal state 

• red indicates that the I/O is active, 
recording in progress

• yellow means there is no communication 
with the I/O 

Buttons for starting and stopping an I/O 
output are also shown.

Camera sequence Click to open the Camera sequence window. 
A camera sequence is a pre-defined "camera 
tour" i.e. a configuration that automatically 
switches through all of the cameras included 
in the tour. Select the camera sequence to 
view from the drop-down list.

Recorded Events Here you can search through recorded 
events. Select a date, a time and press the 
search button and you will get an overview 
of all the recorded events. Select one of the 
events and you will see the actual images in 
the selected event.

4 camera playback Here you can play recorded events from four 
cameras simultaneously. Select a date and 
time, and then press the search button. All 
the events found for the 4 cameras will be 
played starting at the specified date and 
time up to the present time. 
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Pan/Tilt/Zoom and Audio controls

These controls are only visible if the connected camera has PTZ 
capability or a connected audio module. Choose a camera from 
the drop-down list for the controls to appear.

The recording properties for Axis network cameras and video 
servers, e.g. frame rate, image size, are set using the 
Administration part of the program. From AXIS Camera Station, 
click File | Administration to access the different tabs.

Event Log The event log shows all of the alarms and 
other events in the server. Click on an item 
to open the event. To view the full event log, 
select Playback | Event Log. 

Pan/Tilt/Zoom 
controls

Click on the controls to steer the camera 
around. You can also click on the images to 
move the camera. (This feature is only 
available on some PTZ cameras).

Audio controls If the camera is equipped with audio 
capability, the controls are shown here.
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AXIS Camera Station Client software
The AXIS Camera Station Client application is used for remote 
operations on client workstations, where you can perform the 
same tasks as from AXIS Camera Station using a similar user 
interface. 

Install AXIS Camera Station client software

1. From the client workstation, insert the CD and select 
Software then AXIS Camera Station Client.

2. Click Open to launch the installation. 

Important!

3. Next, you will be asked where to install the program. If 
nothing is specified, the program is normally installed here: 
C:\Program Files\Axis Communications\AXIS Camera 
Station Client

You may be prompted to install .NET Framework 1.1. Simply follow the 
installation Wizard’s instructions and click your way through.

You may be prompted and then automatically redirected to 
http://windowsupdate.microsoft.com to locate and install these missing 
Windows components: 

• Windows 2000 Service Pack 4, located here:
http://www.microsoft.com/windows2000/downloads/servicepacks/

• Windows Internet Explorer 6, located here: 
http://www.microsoft.com/windows/ie

Install the missing components, see your Windows documentation for 
instructions. When this is done, reboot your computer and then restart the AXIS 
Camera Station Client installation by clicking 
AXISCameraStationClientSetup.exe on the CD. 
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4. Click your way through the Installation Wizard. When you are 
finished, open AXIS Camera Station Client from Start | 
Program Files or click the program icon on the desktop:

5. Click File | Connection...to complete the installation.

6. The first time you connect, this window will appear:

7. Enter

• the IP address or host name of the server PC where AXIS 
Camera Station is installed

• and, if required, the user name and password.
8. Click OK.

Notes:

• When working with one than one AXIS Camera Station, a list of recently 
accessed Camera Stations is available in the File menu. 

• If there are problems connecting to the server, click Test connection to 
troubleshoot the problem. Port 11007 is used and must be opened in the 
firewall, router, etc.
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AXIS Camera Station Web application
A web browser can be used on client workstations to view 
cameras and perform simple operations, such as review or 
playback recordings. 

Once the service has been activated by the Administrator from 
AXIS Camera Station’s administration pages, clients can access 
the camera views from a browser by typing
http://server IP address/VideoWeb in the Address field

See the online Help pages or the User’s Manual for more 
information. The User’s Manual is available on the AXIS Camera 
Station CD and on www.axis.com

Example: http://10.13.6.128/VideoWeb
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